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Creating Accessible, Section 508 Compliant PDFs with 

Adobe Acrobat Pro DC  

WHAT: 

Accessibility refers to the way we design products, devices, services, or environments to make them 

available to as many people as possible—specifically, to people with disabilities. This includes access by 

people who are mobile impaired, blind, low vision, deaf, hard of hearing, or who have cognitive 

impairments. 

WHY: 

School Webmasters is dedicated to providing accessible web content. What’s more, Section 508 of the 
Rehabilitation Act requires that all electronic and information technology be accessible to people with 
disabilities. Not only are educational institutions bound by these standards, it just makes sense that 
schools would want their publications to be accessible to everyone. It’s important that the documents 
included on school websites be 508 compliant. School websites are our business, so we have a vested 
interest in helping you comply.  

HOW: 

In this document, we will demonstrate how to make a PDF Section 508 compliant.  

We will cover the following items in this document: 

● Tags 
● Alternative Text 
● Color Contrast 
● Screen Flicker 
● Accessible Links 
● Tables, Lists, and Headings 
● Logical Reading Order 
● Bookmarks 
● Scanned PDFs 
● Document Properties/Metadata and Titles 
● Confirming Accessibility 
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Check PDF Accessibility 

Run the Accessibility Checker to ensure the PDF is Section 508 compliant.  

1. From the Tools Menu select Accessibility.

 
2. From the Accessibility Checker panel, select Full Check.
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3. This will open up a dialog box. Click Start Checking.

 
The checker may take a moment to review the document and provide a list of the errors that it found. 

You should review the errors and fix each issue.  

Tags 

Tags help assistive technology read documents by knowing the purpose of each element in the 

document. If you had created the document in another application and enabled tags before exporting as 

a PDF, the tags should already be there, and you would not need to add them again. If, however, the 

report says that tags are missing, there are two “tagging” options in Adobe Acrobat Pro DC. If the 

document is lengthy, then the first option may be best, as it will automate the tagging for you, while the 

second option will allow for more accurate tagging. 

Option 1:   

1. Choose Tools.  

2. Select Accessibility. 
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3. From the Accessibility Checker panel, select Autotag Document. 

 

4. If there are issues, the Add Tags Report will appear, which will include hints for correcting 

errors. 

5. Fix all errors noted. 

  

Option 2:  After Accessibility from the menu. 

a. Select Reading Order. 

b. Select the content to highlight it. This will open the TouchUp Reading Order Dialogue 

box. 

c. If there are items that are decorative or do not contribute to the message of the 

document (like background items), tag these items as “artifacts” so that the screen 

reader or other assistive technologies will skip over them.  

To review your tags, you may open a “tag tree” by going to the View menu and selecting Show/Hide > 

Navigation Panes > Tags. In the tag tree, you can simply click and drag elements to place them in the 

correct order.  

Alternative Text 

Every image must have an alternative text (alt text) attribute, which provides a text alternative to non-

text content. Alternate text allows visually impaired people to understand what the image means to 

communicate. A screen reader will read the alt text in place of the image. The alt text needs to describe 

the content without being too verbose or too vague.  

If the image is only used for decorative purposes and serves no other purpose, the alt text would be null 

(“”), and the image should be defined as an artifact. A simple test to decide if an image serves a purpose 

or is merely decorative is to ask yourself, “If I did not use this image here, what would I put in its place?” 
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If your answer is “nothing,” your image should be marked as an artifact and no alt text is needed. This 

will allow assistive technology, such as a screen reader, to skip the image.  

You may also use a null alt text if the image is described nearby in the body of the page. Even when the 

alt attribute is null, the image must still be tagged as an artifact. 

Complex images such as pie charts, organizational charts, maps, and graphs need a detailed description. 

It is best to include the description in the surrounding content. 

To add alternative text:  

1. In the Accessibility Checker menu, select Reading Order. 

2. Right click on any of the images marked “No alternative text exists,” and select Edit Alternative 

Text.

 
3. Type an accurate description for the image. This is what a screen reader will read in place of the 

image. 

Color Contrast 

Using appropriate colors and contrast enables all users, regardless of visual limitations, to see and 

understand the meaning of everything in the document. We recommend using the color contrast 

checker provided by WebAIM to confirm the colors are within the recommended guidelines. You will 

enter a foreground and background color in RGB hexadecimal format (e.g., #fff or #33f547). If the 

contrast ration fails, you will need to edit the colors used in your document. Check all colors that are 

used to convey information. 

http://webaim.org/resources/contrastchecker/
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Screen Flicker 

Flickering elements, such as animated graphics or scripts, can cause seizures for persons with 

photosensitive epilepsy. They also make it difficult to view the document properly when magnified. 

Section 508 depicts flickering elements as items that flash more than 3 times per second. If this is the 

case, then the element would need to be removed or replaced with a non-flickering element. 

Links 

In order for URLs to be accessible, they must be correctly tagged as active links. It is important that the 

links make sense to a user when read out of context. When a screen reader reads text and there is a 

link, the reader will say the word “link” with the linked text to let the user know that it is a hyperlink.  

A user can also choose to only hear a list of links on a page. If the linked words for the link to School 

Webmasters’ Accessibility Policy are “Click here,” that is the only text the user will hear. Imagine if you 

wanted to find the accessibility link on a page in which the linked text uses “Click Here.” When you ask 

for a list of links, this is what you would hear: 

● Click Here. Link. 

● Click Here. Link. 

● Click Here. Link. 

You would have no way of knowing which link to follow. 

 

A better way to link the text is by including and linking to the actual words in the content of the page. 

For example, “Please read our School Webmasters’ Accessibility Policy” (hyperlinking the actual text). 

The screen reader would read this as “School Webmasters’ Accessibility Policy. Link,” making sense even 

out of context. 

 

Another option to avoid is spelling out and linking the actual the URL. If the linked text were 

“www.schoolwebmasters.com/accessibility,” the screen reader would read this as “w w w dot 

schoolwebmasters dot com slash accessibility. Link.” Again, a better choice would be to add a hyperlink 

to “School Webmasters’ Accessibility Policy.” 

 

To add a hyperlink: 
1. Highlight the text you would like to link. 

2. Right click. 
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3. Select Create Link.  

4. Choose the desired link appearance.  

 
5. Select the link action. 

6. Click Next. 
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7. Enter a URL. (If you are linking an e-mail address, first type mailto: (e.g., 

mailto:info@schoolwebmasters.com) 

8. Click OK. 

If this rule check fails, 

1. From the Tags panel options menu, choose Find.
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2. In the Find Element dialog, choose unmarked links from the Find drop down.

 
3. Select Find. 

4. If the desired link is shown, select Tag Element. 

5. A link OBJR element will be added to the tag. 

6. Repeat for each link. 

Tables, Lists, and Headings 

Clear headings and their reading order assist in navigation of the table’s contents. 

To check a table in a PDF document: 

1. In the Tags panel, expand the tags root to view a table tag.  

2. Select the table tag <Table> and verify that it contains one of the following: 

a. Table Rows (each table row should contain Table Header <th> or Table Data <td> cells 

b. <THead>, <TBody>, and  <TFoot> sections, each of which contains Table Rows. 

3. To correct tags, right click on the selected table and choose Table Editor. 

4. To identify a header, select the cell with the header and right click to open Table Cell Properties. 

5. Define and tag the cell as a Header Cell.  

6. In the drop down menu next to Scope, choose Column or Row. 

If your document needs a lot of correction, we strongly recommend using the original form of the 

document to add the needed elements.  

Logical Reading Order 

A screen reader will read the contents of a document in the order it is assigned. It’s important to make 

sure the contents are read in the order intended. 
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1. From the Accessibility Checker panel, click on Reading Order.

2. Check the option Show Order Panel.

a. If you need to change the reading order, click and drag the item to the proper place.

Bookmarks 

Bookmarks help readers navigate through PDF documents easily. Adobe will fail this check if the 

document has 21 or more pages and does not have bookmarks.  Bookmarks should easily describe the 

contents and are usable by assistive technology.  

Creating Bookmarks from Document Structure 

When the document already has tagged headings, you can use those to create bookmarks. 
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1. In the Bookmarks panel, select Options, and then select New Bookmarks from Structure.

 
2. Select the heading levels that you want to use for bookmarks (e.g., heading 1, heading 2). 

3. Enter a title for the set of bookmarks (e.g., replace “Untitled” with “Contents”). 

Creating Bookmarks Individually 

1. Select the text that you want to serve as the bookmark. Press CTRL+B or click on the New 

Bookmark Icon in the Bookmarks tab. 

2. In the Bookmarks panel, type in the text that you want to serve as the bookmark for the 

selected text. 

Scanned Documents 

Determine whether or not the PDF is a scanned document 

A scanned document may not be read by a screen reader and would need to be converted into a text 

document. There are two simple ways that you can check to see if the PDF is a scanned document. 

1. Try to highlight text in the document. If the text cannot be highlighted, then the document will 

not be read by assistive technology. 

2. From the Advanced menu, select Accessibility. 

3. Select Quick Check. If it is a scanned image, a message will appear explaining that the document 

contains no text. 
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Making a Scanned PDF Accessible 

Converting a Scanned Document to Text 

1. Open the Scanned Document in Adobe Acrobat Pro DC. 

2. Select Edit PDF from the Tools menu, and an automatic process will convert the document. 

 

Checking the New Rendered Document 

After rendering, the document will become a Text PDF. However, if during the process Acrobat was not 

able to translate something, it would label the section as “Suspect.” You must review the document to 

find and fix these suspects and make any other necessary corrections. There are two ways to do this. 

1. In the Document menu, select Recognize Text Using OCR. 

2. Option 1: Select Find First OCR Suspect.  

a. A dialogue box will appear, showing the first suspect in the text of the document. The 

program’s best guess will appear in the suspect field. 

b. You may type in what the correct interpretation is in the suspect field and then click 

Accept and Find.  

c. If the program brings up something that is not meant to be read as text, such as an 

image, then select Not Text. 

3. Option 2: Select Find All OCR Suspects.  

a. This will create a red box around all the suspects in the document. 

b. Click on a red box, and the Find Element dialogue box will appear.  

c. Follow the same instructions as option one to make and accept the corrections.  

Metadata, Document Properties, and Document Titles 

Metadata is the information and data provided about a file. Editing the metadata will help identify 

accessible PDFs to search engines.  

The title of the document is important for the reader to identify page content without having to sort 

through and interpret a file name. To be Section 508 compliant, the document title needs to be specified 

in the file metadata. 

1. Go to File and Properties. 
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2. In the Advanced tab, check to make sure the Language field is set to “English US” (or the correct 

language per the document).

 
3. From the Description tab, fill in the corresponding information in the Title, Author (refer to your 

school or company’s policy for whom to list as the author), Subject, and Keywords fields. 

a. The Keywords field should include at least two specific and descriptive inputs that are 

lowercase and separated by commas. (e.g., “Seattle Washington, section 508, 
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compliance training”).

 
4. From the Initial View tab, under the Window Options section in the Show category, select 

Document Title in the pull down list. 

Confirm Accessibility 

We recommend running the Full Check from the Accessibility panel again to confirm there are no 

errors. Remediate as needed. 




